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1. iR

Lattice Diamond & THAFIRHE T S el T HAISEEL TR, L 14X AU . KTh#E
13k FPGA ZEMYBEAT T A —— 13 FAIR 3 BE AR 3 2 FPGA I N 8T e 22 R 1%
B UE AR PR R

> HET GUI I 5E % FPGA BT IS IEI 453

> Al 2 AN ARSI DL R 5 W BN LT I H AT TR R

> SRAEE AT REE B0 AR E IR SN Y

1E Lattice B WA LL4 2% T #5087 11 Diamond LE, FHF Windows R4 Linux &5t

2. Wi

2.1 Diamond B4 T £

1. #| Lattice B MM, F4n T Mk
http://www.latticesemi.com/zh-CN/Products/DesignSoftwareAndIP/FPGAandLDS/LatticeDiamon
d.aspx

NEON RLERE RS 50T Diamond B AR AL

2. MR AR AT 2%

3. AU VR RTE DL BE R AR . CHRFE SR, e 9%)

2.2 Diamond Z3EF1E:

1o XU FTIF N8R G R BRI RGERIRRASAT T SR H AR .
2. BENLIRE T


http://www.latticesemi.com/zh-CN/Products/DesignSoftwareAndIP/FPGAandLDS/LatticeDiamond.aspx
http://www.latticesemi.com/zh-CN/Products/DesignSoftwareAndIP/FPGAandLDS/LatticeDiamond.aspx
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Lattice Semiconductor Diamend 3.6 (64-bit) Setup

MachXO03L
MachX02
MachXO
ECP5

LatticeECP3
LatticeECP2/M
LatticeXP2
Platform Manager 2

EEEATTICE

InsstaliStiel]

Welcome To Lattice Semiconductor Diamond [64-hit] Setup

| Cancel

Lattice Semiconductor Diamend 3.6 (64-bit) Setup

License Agreement

MachXO03L
MachX0z2
MachXO
ECPS
LatticeECP3
LatticeECP2/M
LatticeXP2
Platform Manager 2

SELATTICE

InsstaliStiel]

3. gty Next, BEAWRMGE, ARESAILIR L, BRBEMZ T ..o

the termz and conditionz of thiz Agreement.

b. Pursuant ta thiz Agreement, Licensee may [i] phyzsically tranzsfer any Software from one
computer to another provided that the Software is used on only one such computer at a time
and [ii] uze the Software and any output filez generated by the Software for the sole purpose
of desighing and programming semiconductar components manufactured by or for Lattice and
zold by Lattice or it autharized distributars [''Lattice Devices'] and [iii] make one (1] copy of
the Softveare for Licenzee's own uze zolelp for backup or archive purpozes. Licenzes may
alzo merge the Software [or a portion thereof] inta any other software to form an updated
work; provided that, upon termination of Licensee's licenze, the Software shall be completely
removed from the updated work, and treated az if permizzion to merge had newer been
granted. The use of any portion of the Software included in any such updated work, remaing
at all times subject ta the termis and conditions of this Agreement.

c. Lattice DiamondTh Programmer and ispV T Software Licenze Terms. Notwithstanding
Section 2b of thiz greement, Lattice grants ta Licensee the right to uze and distibute, as part
of Licenses's systems, the Lattice Diarmand Prograrmmer Software and the ispét Software (S
he Programmer Software?, in compiled version, for the sole purpose of pragramming and
reprogramming gilicon devices supported by the Programmer Software. Motwithstanding the
faregaing, any output files generated by the Software may only be used ta program Lattice

LX)
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4. fBolrediigis, BRI LR C £

Lattice Semiconductor Diamend 3.6 (64-bit) Setup | S|

Choosze Destination Location

MachXO03L
MachX02
MachXO
ECP5

LatticeECP3
LatticeECP2/M
LatticeXP2
Platform Manager 2

Browse...

InsstaliStiel] ‘ < Back H | Cancel |
5. e )E, sl Next, #EN T HIETA .
Lattice Semiconductor Diamend 3.6 (64-bit) Setup | S|

Product Options

produc | & ddition: nay be

Diamond 7 | ) 1
MachXO3L 1721 7 ME | tioh installs Diamand 3.6,

MachX02 [¢] Svnplify Pra for Lattice 474.7 MB
<] Active-HDL Lattice Edition 1387.1 MB
MachXO =] Programmer Dirivers 0.4 B

ECP5
LatticeECP3
LatticeECP2/M
LatticeXP2
Platform Manager 2

HILATTICE |

[ristealfSiald < Back H Mest » | Cancel
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6. HOBEFEBOANRE, WA, HER X RFRES. il Next, BEASCHRAZBE.
LORRAT DR S B B, BUCUERN AT

Exizting Faolders:

Altera 15.0.0.145
Analog Devices
Atrmel

ATHMEL Corporation

BCL easyConwverter SOK 4

Cypress

EAGLE Layout Editor 7.5.0
Fasrmail

Free Al Wiewer

Games

&R Systen:

Lattice Diamond 3.6 [E4-bit]

7 H TR VE W B . B USB key, Bt X At ¥ Node-Lock License . 5% T Node-Lock License
F1 Floating License [f][X 5 7] LAZ 2% T X ME &
TestComplete V78 ¥FAJIE (Floating license)5 1 /5 8 %2 ¥F AT IE(Node-locking license) [X 7]

Lattice Semiconductor Diamond 3.6 (64-bit) Setup

Active-HDL Lattice Edition Selection

These are the optionz far uzing Active-HOL Lattice Edition simulatar saftware, |F pou zelect
"Floating Licenze wia USE key" option, the drive will be installed later during thiz installation

@ Mode-Lock License

(71 Floating License via USE key

[nztallshield

[ P et » ][ Cancel

8+ il Next, AT RTERE.
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Lattice Semiconductor Diamond 3.6 (64-bit) Setup e S|
Create zhortcut on dezktop
W
whauld yau like ta create a shartcut on vaur computer's desktop ta launch the Diamond
software?
@ No
InstallShield -
[ et = } [ Cancel
9. sl Next, EHIE %4 USB K3, IXANLIfEE!!!
Lattice Semiconductor Diamond 3.6 (64-bit) Setup e S|

Programmer Download Parallel/U5B Port Driver

% -V
Do you wizh ta install ar update the Parallel/LUSE Part driver at this time?T hig driver i required
for Windows YWista Windows ¥ \windows 3 installations.

@ No

[rztallShield -

]| o

10, MR —RINWEG, BWHEFIHTERENE.
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Start Copying File
Revi { g%

MachXO03L
MachX02
MachXO
ECP5
LatticeECP3
LatticeECP2/M
LatticeXP2
Platform Manager 2

fEsLATTICE

InstaliSiield

Lattice Semiconductor Diamend 3.6 (64-bit) Setup

Setup tazks performed to the following folder:
Chlzochdiamondha B_xB4
Options selected to install:
Diamond Components
Diamond Project Mavigator
License

LATTICE-FPGAs

FPGAs

ECF5IJ-ECPELUM

LATTICE ECP3

LATTICE ECP2-ECF25
LATTICE ECP2M-ECP2MS
LATTICE SC-5CH
LATTICE =P2

Machx=0

LATTICE %P

LATTICE EC-ECF

4

o

11, xidhi Next, IEHEANZRIAT. BAFLVPME— TANLRS, RERTRE 2.

Start Copying Files
it f

MachXO03L
MachX02
MachXO
ECP5
LatticeECP3
LatticeECP2/M
LatticeXP2
Platform Manager 2

EATTICE

InstaliSiield

Lattice Semiconductor Diamend 3.6 (64-bit) Setup

Setup tazks performed to the following folder:
Chlzochdiamondha B_xB4

Options selected to install:

Miamnnd Camnnnenks

@ Setup iz evaluating vour system. One moment pleaze. .

LATTICE ECP2-ECP25
LATTICE ECP2M-ECP2MS
LATTICE SC-5CH
LATTICE =F2

Machx=0

LATTICE %P

LATTICE EC-ECF

4

| Cancel
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12, —MWACER) PC HLER AT LB PPAG . HEN .

==

Lattice Semiconductor Diamond 3. P b

[ ] A ’ E Lattice Semiconductor Diamond 3.6 (64-bit) Setup
[ [ L ] , C

Instaling Diamond Components.
T\, wi_Latch_amay_primary vhd

READY TO USE REFERENCE DESIGNS s LATTIE

=Proven Pre-Engineered
Reference Designs

=Popular Functions
12C
SPI
GPIO Expander
PWM

Lattice Semiconductor Diamend (64-bit) Installation Completing.

Inzstall5hield Wizard Complete

Dial Ware i omplete.

MachXO03L
MachX02
MachXO
ECP5
LatticeECP3
LatticeECP2/M
LatticeXP2
Platform Manager 2

Tunning

gEATTICE

[nstaliShiald ¢Back | ! Cancel

14, A Finish, 5ERESE.
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2.3 Diamond 34t -

1. Diamond MAFAMXIRAL 1 ] 50 5y F 3/ 852, 1 B3Rt e 2 Vi AR 4045 FH P e it
FEVPAL Diamond HH SCHEI AN SERDES (I # I MERE . S VP Rl ESREL 40 T 5, B 2 AE
Lattice B WM — MK (FREMRAED.

2. ViAW TUTH http://latticesemi.com/Support/Licensing.aspx, i 31— F4 VT AliE.

Lattice Diamond i x4

EA—I N L EESEEE | EEEEiEs

LATTICE
*” DIAMOND

Lattice Diamond2EiFoliiE

Lattice Diamondigit S{HEE FEAEEENTHII TR | T7 18R, (RIFERTE
BT FPGAZREHET F ki, fETIHE SR EE T rHSDiamondS 8= 5a9~F
SERDESHIRRHAIERE.

FEE—MTONEESE

YIEEMACHERE ( 12651 <8EHE )

FE—EESTOlE

3. HENSEEME, A license.dat ST, B2 A& BT IRHIBAE .


http://latticesemi.com/Support/Licensing.aspx

STEP-MX02 ATt

Please follow these steps to request your Lattice Diamond Free Software license:
1. Review and update your Web Account Information below by clicking on the Update Your Account button.

2_Fill in the Software License Request Form and Submit.

Host NIC: You can find your PC Network Interface Card ID by opening an M5-DOS window, typing "ipconfig /all” and pressing Enter.
The Physical Address is a 12-digit hexadecimal value split into pairs with dashes, like this: 00-01-02-66-1D-E0
Please enter this information without dashes like this: 000102661DEQ.

After you successfully complete and submit this form, a new license file with instructions on how to install it will be e-mailed to you.

For any questions, email lic_admn@latticesemni.com

If you have experienced an Aldec license check out error, please check out a new license.

Software License Request Form
Note: The license file will be sent to the web account email address:

A

Host NIC (physical address) *:
* required field

drify that | am not an employee of Cadence Design Systems, Mentor Graphics Corporation, or Magma Design Automation

Generate License

(click once)

NOTE: This form requires JavaScript to be enabled in your web browser in order to process your reguest.

4, TR REY, CHIRNMAGHIE R E. RFHEHTE N license.dat S ILF| %
B H T license XU, AT N: D:\lscc\diamond\3.6_x64\license\

@L)v| Lo EHEES (R) v lscc » diamond » 3.6x64 » license v|¢,~|| HEE license p|
KﬁitF_J RHE =BV IEM #E8H
Hid - BEEEF - HEE v FE =+ [ @
i e ’ BREE = A
B F= 2015/11/22 12:33  DAT =2f%
| =R  license 2015/4/12 1819  IrACr
G ERRanaE
=g 3
| B8 am
=)
Bl
I dex
«F =58
1 E
At - »
2=
/|

FPL5ER License SCAF ¥, AT LAJT4R{E ] Diamond #EAT it 1
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EEIN

AT AT I Diamond BAF A BLAN AR, MIERRIA AL B v B A [

E;Errc:r M

P
{ y
| |
L. i
o

License checkout failed.

Check environment variable LiVI_LICEMSE_FILE

et to
Chlsectdiamondy3.6_xB68\licensellicense.dat:f\modeltech_10.1a\L1
CEMSE.TXT I

Please check your license setup to ensure,

1) You have a valid Lattice license file pointed to by

LM _LICENSE_FILE

2) The License daemon is started at the server if you have a
floating license,

Failure was caused by

Mo such feature exists.

Feature: LSC_DIAMOMND A

License path;
Chlsccidiamond3.6_x6d\licensellicense.dat:f:\modeltech_10.1a\L1
CENSE.TXT;

FLEXnet Licensing error-3,357

For further information, refer to the FLEXnet Licensing End User
Guide,

available at "www.macrovision.com”,

#E

fiE R TT A
AR R R, BEA TSR b R SR S .
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P—rey
) = =eEw » zemz2 » =5 -4 | mzenzs o
I FRE EEN IR EEH)
.@ -
T 3 &
. EEEA EIAOEREE
r&l BEEES Windows fgd=
¥ mEaE Windows 7 iE8kE
5 = KEFRE © 2009 Microsoft Corporation, RERTEHF.

¥ maEsRs Service Pack 1

m

=&
T ﬂ Windows {RESHEE]
HHEEE: Intel(R) Core(TM)2 Duo CPU  TB670 @ 2.20GHz 2.20 GHz
EEFEFRAM): 6.00 GB
BiEeE L 64 GRR{ERGE
ZEE SHIE. E N AT it e
Windows Update HENER S Tiens
il HEE: Heng-PC Gmmas

= = 2= = - =

R R ARG RE . EHFEEH, FAEEER!

=GEE et |

L e Z@Z2Z—/

itENE | EE | SR | SR | EE |

ERITHEHEN . BUENEERER-
G
MRS AHBEER PITERER . LURERATE

.

HPEEME
SEEFaENEERER
BehingirE i g

FinEEh « RimEMAmELER

| WeEgmw... |

[ ®E || EE || EA® 'J

AR E SN, BEHPBREY R EAEES KRG E LM_LICENSE_FILE FH 5= 148
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=

% o

' 5

T =S — [
Hen. (4058 25 ()

=8 B =
ALTERAOCISTE. .. Fihaltera'lS 04%h1d |E |
Fath d:"Frogram FileshATMEL Corporat. .. =
Q3YS_ROOTDIIR F:halterahlS Ohquartushzope_bui. . .
TEMF HISERFROFTIESY ArmTlata'iTaral A Tamn d

(g, | [wmEe... || mso |

FEREE 5)
=8 {8 =
FF_HO HOST C... WO |
LATTICE THI ... C:‘lsc_enwv

m C:'l=zcechdiamond' 3. A_xE4'1icensze. .|
WIMERE (F FR__ 7 - »

(EEw... | [REO... | [ mBo |

| W= || BE |
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3. SIBFE LR

a

3.1 HE—NTLTE

1. {£ Diamond BT I, &+ File>SNew>Project, #4735 LFEG# .

2. BUEUHT TR, il Next, JTIR TR IRE.

r __ — - %
File | Edit View Project Design Process Tools Window Help
R I* | Fie.. Ctrl+N | EEEG
Open M Project.. Ctel+Shift+N wiEAR i@
Add & Implementation... ' ' @i;J
Close Ctrl+F4 Strategy...
Close Al ject: = User Guides  Reference [
Close Project Upen..... B Lattice Diamond Guides |ﬂ
Hew. .. User Guide Strategy
(| -
e Cirl+5 Managing Constraints
Save As... Projects Hardwars
@J Save Al Ctrl+Shift+S  tware Upgrade Recommended o Elatform i How-To
Save Project ently running Lattice Dismond software wersion u GSiSCI'gFIeI' SEM | attice
z nos i Modules
Save Project As.. m ] Entering the A -
Archive Project...
Discard Modified Preferences B
T Print Preview..
@ Print... Ctrl+P
Recent Files 3
Recent Projects 3
ot Mem Usage: 92,024 K
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« Mew Project [ & ﬂh,l

Create a Lattice Diamond Project

Thi=s wizard will guide wou through the creation of a
Tiew project.

To create a Lattice Diamond project wou will need to
provide a name and lecation for wour project. Hext wou
will import source files. Tou may adjust implementation
options. Finally you will process the source files to
produce a programming file for a specific FPGA dewice.

To contimme, cliclk Hext.

< Back Hext > | Cancel ]

3. WETEAMM IR, WA TREREBAEEIFRE TRk, &
WA AR A = AE E— R AR AR, 35 A2 L FF E:/Step_FPGA, U And_Gate
TARFTH ST BIRAFAE Step_FPGA . SE/BEE )5 midd Nexto
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-

.
* New Project [ﬂﬁ

Project Hame

Enter a name for wour project and specify a directory where the 0 o
project data files will be stored.

Froiect

Hame: and?|
Location: F:/™orkspace/fpzaprojectfand? gate - Browse. ..

Implementation: -

Hame: impll

Location: F:/Workspace/fpgaproject/and? gate/impll

| < Back ] [ Hext > ] [ Cancel

A, ININFHIRBET ST B R SCF . A L EREE: 4500 2) 1% Copy source to implementation
directory, 7 I< 52 J5 S04 . 50 75 U8 I B2 Nexto
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- B
* New Project M

Add Source o
#dd HDL, EDIF netlist, LFF constraints, or other files. ’%

Source files: Add Sourca. .. Remowe Source

Copy source to implementation directory

| <Back || Fext > || Concel |

— —

5. #efFik$E: LCMX02-4000HC-4MG132C, 25 %R N KIFT/RIE R, 58 B J5 A Next.
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-

L

+ Mew Project

Select Device

Specify a target dewice for the project.

Select Device:

Family: Dewice:
LatticeECP < || LCMXO2-2000HC £
LatticeECP2 LCMXO2-2000HE
LatticeXP || | LCMXO2-2000UHC
LatticeXP2 LCMXO2-2000UHE
MachXO LCMX02-2000ZE T
MachX02 = || |LCMX02-4000HC =
MachXO3L LCMX02-4000HE
MachXO3LF LCMWXO2-40007ZE T
Platform Manager LCMXO2-7000HC -
Platform Manager2 = || ¢

Ferformance zrade: ()

Fackagze type:

la

v | [csBeat3z

Operating conditions:

[Commercial

)

Fart Hames:

|| Leika2-4000HE - 4nG1 32

Select ASC Dewice:
Fart Namesz

L-ASC10-155431

Humber=

a

Online Data Sheet for Dewice

Al

Dewice Information:

Yoltage: 25W 33T

LT 4320

Registers: 4320

EBE Bit=: 92 2K

EBR Blocks: 10

Dist RAM: 34560 |
DSF: ‘e i
FIL: Z

ILL: 1]

PCE: =

APIO: >

PI0 Cells: 280

PIO Fins: 105

Max Programmable I0=: 104

YMOH Fins: 1]

IMOH Fins: ]

TMOH Fins: 1]

Trim/Mar Pinz: a

HYOUT Pins: 1]

GPIO: ]

| <Back || Fext> || Comcel |

6. Ga T HER, AR E=45aTH, BEANBEHE G&8TH, SEAKE.
H#% Nexto
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- &

[ Select Synthesisz Tool u_,&"’;_:_\
Specify a synthe=ziz tool for the implementation. vlb';‘;')‘v)
K 4

Synthesis Tools:
) Synplify Fro
Precizion

@ Lattice LSE More information

[ % Bacl ]i Hext > i[ Cancel ]

L

7. MEITHE, W LRESECA M. Ml Finish 5t OK T .
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+ New Project m

Project Information x
The new project will be gemerated with the following specifications. .‘?
Project:

Project Mame: and2

Project Location: F;/Workspace/fpgaproject/and2_gate
Implementation Name: impll

Device: LCMXO2-4000HC-4MG132C

Synthesis Tool: Lattice LSE

| <Back || Fimish || Cencel

3.2 IR

1. 7E Diamond B4R L, &+ File>News>File, HEATHI TG .
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+ Lattice Diamon

Edit View

Project Design Process Tools Window Help

| New 1" | e [Fie.. Crl+N lIEEE T
Dpen & Project. cul+shifteN | 5] (2 @
Add » : =
Implementation... B
Close Ctrl+F4 Strategy... a
Close All
Surmary i
Close Project . |
roject =
fﬂ Save Ctrl+5 E Project S... Ll |Module Name: and2 Synthesis: Lattice
e Ao rocess Rep... L5E
@] Save All Ctrl+5hift+5 j Map Implementation impll Strategy Name: Strategyl
] Place & R... Hame:
Save Project :
2 j Slgnalfpad Last Process: State:
Save Project As... " JEDEC
T = 2 : T =
Kichive Project... boahisic Rap. i+ Target Device: I_.F._'.t:‘.}_{{??_MOOHC Device Family: MachX02 o=
Discard Modified Preferences B
4] Print Preview... lscc/diamond/3.6_x64/ispfpga/userware/NT/SYNTHESIS HEADERS/machxo2.v
=T Cirl+P rors, and (0) warnings
Recent Files » 4
Recent Projects 3 J il
Exit :
Mem Usage: 105,476 K I

2. FESCAFGIE S, PR EIE R SCIFIRAL . AU Verilog HDL BETF 30, 472K, %
B FR. midr Yes, SEREIE

-
« Mew File m

. B O a -

Categories: Sourece Files:

Source Files ‘! LDC Files

Other Files P9 Power Calculator Files

RS Reveal Project Files
Schematic Files

¥ Verilog Files I
f ¥ VHDL Files

ES) EDIF Netlist Files

Y Preference Files

Verilog Files

Hame: I and? I

F
Location: F:/Morkspace/fpgaproject/and?_gate

m Add to Implementation 1mpll

[ Hew || Clese |

L — = T—

3. FEHTBIEIN Verilog SCFHHH#EAT Verilog HDL RG4S . 4055215, (RA7. IDE HEKH
B 3] 220 Hierarchy(JZR) & H o
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» Latice Diamond - Source Editor - [F/Workspace/Tpgsproject/endZ_gate/and2:] I o - o

File Edit View Project Design Process Tool

-G B @ e ¥ m

[

YEASAECESCBEGE

Window  Help

RAAR  EEH EHEEDQ
QoclB” MEEUEHE @

File List & x
2 and2
i LCMX02-4000HC-4MG132C
4 || Strategies
% Area
[ 1O Assistant
[ Quick
[E% Timing
Strategyl
4 [FH impl1
4 |, Input Files
¥ andawv
). Synthesis Constraint Files
|, LPF Constraint Files.
[ andzlipf
|| Debug Files
Script Files

4

. Analysis Files

Programming Files

([ Stert Page [) | [ Beports [ | [F snizv @ |

=[x

emocdule and

o (

a,
b,
@

input
output

and(c,a,b);

endmodule

File List | Process | Hierare hy <

Output

(VERI-1482) Analyzing Verilog file C:/lscc/diamond/3.6_x64/ispfpga/userware/NT/SYNTHESIS_HEADERS/machxo2.v
(VERT-1482) Analyzing Verilog file F:/Workspace/fpgaproject/and?_gate/and2.v
INFO - F:/Workspace/fpgaproject/and2 gate/and2.v(1,8-1,12)
INFO - F:/Workspace/fpgaproject/and?_gate/and2.v(1,1-13,10)
Done: design load finished with (0) errors, and (0) warnings

(VERI-1018) compiling module and2
(VERT-3000) elaborating module 'and2'

Output | Tcl Console | Error | Warning | Infok |

Ready

Mem Usage: 120,744 K

—— =

ARSI

module and2

(

Input

1
2
3
4
5. c
6
7
8 Output
9

a,b;

G

10. and(c,a,b);

11.

12. endmodule

3.3 ZZE

— T = ==

Y B UFARRY, FTEHATICUE. 7E IDE £, &P Process. XUii Synthesis Design, XJ ¥ it it

— ey
ITERE .

Synthesis Design: 25 & & IRA1E 5 IR 1 B 4L a1 2 HL B IS RE , [RIRSEF XS Lattice 1Y

FPGA 34T Ttk



STEP-MX02 #A:FAf

» Latice Diamond - Source Editor - [F/Workspace/pgsproject/endZ_gate/and2:) i T oo 7|

G A Tools Window Help
P8 me i Oh 6 S EED ]
PESAECESCEEG A=Y MER @

Process 5 % [ ([ Stert Page [| | [ Beports () | [ snizv @ | [5]%]
4 & Synthesize Design emodule and2
& Lattice Synthesis Engine. o (
4 2 Map Design -
1 & Map Trace "
[F1 2 Verilog Simulation File b,
[F] & VHDL Simulation File c
4 2 Place & Route Design );
[[1 & Place & Route Trace
. [ /O Timing Analysis input a,b:
4 T Export Files sutput o
[[] & 1BIS Model P A
[£] & Verilog Simulation File
[£] & VHDL Simulation File and (c,a,b) ;
& JEDEC File
[F] & Bitstream File endmodule
Fils List | Process | Mierarel by < n >
Ontput i 5 x
(VERI-1482) Analyzing Verilog file C:/lscc/diamond/3.6_x64/ispfpga/uservare/NT/SYNTHESIS_HEADERS/machxo2.v
(VERI-1482) Rnalyzing Verilog file F:/WDIKEDBCE/fDEaDI‘D]Ecc/andziqace/andz.V
INFO - F:/Workspace/fpgaproject/and? gate/and2.v(1,8-1,12) (VERI-1018) compiling module and2
INFG - F:/Workspace/fpgaproject/and2? gate/and2.v(1,1-13,10) (VERI-8000) elaborating module 'and2'
Done: design load finished with (0) errors, and (0) warnings o
Output | Tcl Console | Error | Warning | Infok |

Ready Mem Usage: 120,744 K
—— —

BT TR, AR ITHT I 2 S N T oo o A AR ER LA X X oo o IBAFITE 1R
REL SR AT, HERNS?
Frocess /x|
4 % Synthesize Design|

% Lattice Synthesis Engine
a Map Design

= Map Trace

= Verilog Simulation File
2 VHDL Simulation File
4 Place & Route Design

= Place & Route Trace

= 1O Timing Analysis

EEE

O =

4 2 Export Files

IBIS Model

Verilog Simulation File
WHDL Simulation File
JEDEC File

Bitstream File

ti

ittty

OEOEOO

Fi-=* Fre-- Hierarchy——Fost See

3.4 BB

1. ETHEB PR =475 — N EbR,  mly BVAT N8 B2 S 57 1



STEP-MX02 #A:FAf

File Edit View Prcg'ect Des?gn Process To-ols Window Help
A-B-HIE pu¥Dh eERRQAAQ EE EEED

-la::eﬂ%a{;ag@@lﬁ ReEPQ-BsY FEIREHE O
Frocess 5’ X | é—. Start Fage D | Reports | | @}md‘? "m |

B # 1% % Tools->Spreadsheet View

« Lattice Diamond - Source Edrtoif [F:f\l\!'_t_)r‘kspace/f?gaproject{andZ_gate,r‘andZ.v] \L
File Edit View Project Design Process Tools] Window Help
@ - @ - El Eﬂ] | | g ﬁh ﬁ: Eﬁ Spreadsheet View I
CEOREE G G E @ B ek View EEFII @ __
Procsss 8 % {2 Device View Bf andz.v 3 BB
4 %Y synthesize Design Bl Netlist Analyzer
% Lattice Synthesis Engine = Netlist View
4 3 Map Design NCD View
Bl 3 Map Trace
B Verilog Simulation File B:iu IPexpress
-, : o
VHDL Simulation Fil
. 0% S é i @; Reveal Inserter
4 L Place & Route Design
7] ¥ Place & Route Trace @ Reveal Analyzer
- il .
. B E If.O Timing Analysis Hoorplan View ,b,'
4 & Export Files e 8
Fl 2 1815 Model @ Physical View r
- ’ : v .
] bt Verilog Simulation File (@ Timing Analysis View
VHDL Simulation Fil
D : |rnu S %] Power Calculator
2 JEDEC File 4 .
7] & Bitstream File 2i ECO Editor
i} Programmer
€)  Partition Manager
“= Synplify Pro for Lattice
it | Pee | Hiersrehy—Post S | |[< | @) Active-HDL Lattice Edition s
Output g X
e A ’D"B Run Manager -
Peak Memory Usage: 55.492 MB -
7 Simulation Wizard
Elapsed CPU time for LSE flow : 1.27 Clear Tool Memory
Done: completed successfully Oplions... EI
Output | Tel Comsole | Error | Warningt | Infok
Spreadsheet View Mem Usage: 123,676 K
T —— — — — e |
s 3
2. EIBCE LRI
| Start Page [ Reperts [ Ezf and2. v |2 | @Spreadsheet Yiev * [J
Name Group Bv Pin BANK BANK VCC VREF IO TYPE PULLMODE DRIVE SLEWRATE CLAMP OPENDRAIN
1 ~ S All Ports N/A N/A N/A N/A N/A N/A N/A
1.1 v & Input MN/A MIA MN/A MN/A MN/A NIA N/A N/A NIA NIA NIA
1.11 » a N/A N/A N/A LVCMOS25 DOWN NA NA ON OFF
1.1.2 ® b N/A N/A N/A LVCMOS25 DOWN NA NA ON OFF
1.2 v Output N/A N/A MN/A N/A N/A N/A NIA N/A N/A N/A N/A
A2 € N/A N/A N/A LVCMOS25 DOWN 8 SLOW OFF OFF

EWEETENLRWN T, a--L14, XN R B8 K1; b--—-M13, XTRR R 3%
’Sékz c----N13, X IHR K b LD1. [FIRS 4B B 10 ZRAY#A %2 3] LvcoM33 (3.3V HF),
TR E)G, Ctrl+S {17 E .
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Name Group By Pin BANK BANK VCC VREF IO _TYPE PULLMODE DRIVE SLEWRATE CLAMP OPENDRAIN
L s — - - s o o - -
11 4 @ Input NIA NIA A MNiA N4 NIA NIA INIA MIA M
111 » a NIA L14 1 Auto NiA NA NA OnN OFF ol
112 b NI m13 1 Auto NIA NA NA ON OFF ol
12 a Output NIA NIA A NIA NIA /A MIA NIA NiA NIA N/A Wi
121 c MIA N13 1 Aute NiA LVCMOS32 DOWN 8 SLOW OFF OFF ol
4 | m | 3
Port Assigmments | Fin Assignments | Clock Rescurce Route Priority | Cell Mapping | Global Preferences Timing Preferences Group | Mize Preferences

3.5 A pgm i

1. AL RE B B IR G, EARA g BT e B R . AR AT R
AT IR, X RREGE A EDA T H B 31 5E K-

Map Design: BSS/E R 3G A AR I T G FRL I G L8[ a2 4 H A2 5 B4 v Al
K AN SREE FPGA W JT G5 KOG FE B RE o 9 A 1) Pl 332 A fh 28 A 4
N SE I 5 iR R S5

Place&Route Design: A7 Jaj i £& I F2 it 2 AR 4 it S sk 2 Pl 72 2R (1) 2 T FPGA i8S | FEL R 1B 4R AE 1%
FPGA &5y LTI #EAT M) BEAG R A B 2

Export Files: % Higm 3 S 2E/NHY TF AR B MX02 R 516 A 75 EH JEDEC SCAFEAT 4
PENE, BTDAEIX BB JEDEC File T/A) ik I
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Process
v % Synthesize Design
% Lattice Synthesis Engine
| v 2 Map Design |
[1 2 Map Trace
[] & Verilog Simulation File
[] & VHDL Simulation File
| v 2 Place & Route Design |
# Place & Route Trace
[] 2 1/0 Timing Analysis
v 2 Export Files
2 IBIS Model
[] 2 Verilog Simulation File
[] 2 VHDL Simulation File
[ 2 Bitstream File
I [v| & JEDEC File

Fil-- Prag: Hierarchy—Fost Synthe:

2. XGER NP, B Bshisirizad . WA LA R Export Files T, [ 256 B PA

EBRR
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Frocess B X

4 % Synthesize Design
%L Lattice Synthesis Engine
4 % Map Design
I :.-" Map Trace
[ & Verilog Simulation File
[ 2 VHDL Simulation File
4 % Place & Route Design
[[] 2 Place & Route Trace
[ = IO Timing Analysis
a gz Exp::urt Files
[ 2 IBIS Model
[T ¥ Verilog Simulation File
[] ¥ WHDL Simulation File
[¥] (%L JEDEC File|
+ Bitstream Flle

.
’

l

O
l

| Fi--* | Fre=- |]'[ieraru:h3-'———Pl:-5t M=

3.6 T#

1. SER g SO, AT BB g 3 S0 R 3R BIR R B 1 X BLR AT XS STEP-MX02

N T RAR

K STEP-MXO02 JF A MR IE S USB £k 21| PC HLHL, IXIN B i fii (1 e 4 B4 i 17—

USB #4780 4%, IXULH T ARAF KN 22 222 1) -
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& eaeES
WEEF)  HBMEA) BEN)  MEENH)
o« o HE B

& Jungo

0 aamse

O (&raE

- BEEIRENEE
» S TRAEIHISE

= FTENRAFY

P i

~ @ %0 (COMA LPT)
@ USB Serial Port (COM9) |

0 HE
> [ Y5HNER

0 BF
i NEEHBANGE
B ougins
i EE. MmO
0 suFnsEtbEEHe S
o § ERETRGHE

Realtek USB 2.0 Card Reader

USB Composite Device

| USB Serial Converter |
USB 1RE£:38(USB 3.0)

o Effues

I FReRiERERSE

il o el ol

Intel(R) USB 3.0 &T¥ R@EH1#54158 - 1.0 (Microsoft)

i
L1

2. ik B LR PR =47

File Edit View Project Design Process Tools Window Help
A E-HIB ruEOn
CECHEBSE%CEEG M

# "] BL % # Tools->Programmer .

Q& B
K0Py FREEE O

Frocess 5] X| ( Start Page || |
10

| Reports |:| | g’ and?, |:| | ﬁSpreadsheet \fiewm [
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r

# Lattice Diamond - Spreadsheet View

e @ aa

= [ B e |

File Edit View Project Design Process [Tools] Window Help

A-E-HFB 2uy®
¢ESRBLESCGEE

8 %

Process

4 T synthesize Design

% Lattice Synthesis Engine
4 % Map Design

Bl : Map Trace

1 Verilog Simulation File

] & VHDL Simulation File
4 % Place & Route Design

7] ¥ Place & Route Trace

B2 o Timing Analysis

uR B el

¥

|

Spreadsheet View
Package View
Device View
Netlist Analyzer
Netlist View

NCD View

IPexpress

Reveal Inserter

Reveal Analyzer

[ anizev O

CRNES BE 86 £ C0RBOES

Performance: 4
Package Status:
Performance Hardware Data Status:
Finish loading physical design infoj

et :
Floorplan View
4@ Bwot e K Physical View
] 2 18IS Model - v
[[] & Verilog Simulation File Timing Analysis View
] 5% VHDL Simulation File Bomer Calculot
- . er Calculator
[ Fi
ECO Editor
A]]
= Programmer
o
£ | & Partition Manager
=
¥ | == Synplify Pro for Lattice
Fivw | Pee | Hiersrehy—Pest o || ¥ || @) Active-HDL Lattice Edition
Output
% Run Manager
Device: LCHMXO2-4000HC 5’3 g
Package: CSBEA132 2 Simulation Wizard

Clear Tool Memory

Options...

il EEED

mEENEE @

[ Spreadsheet View [

By Pin  BANK
H.'il [.]."'_'
NI MIA
L4, | 11
M3 101
NI NIA
N13(.. 101

BANK VCC VREF
TIA MIA
MIA MNIA
Auto NIA
Auto MNIA
MIA NIA
Auto N/A

| =] =]

10_TYPE
LVCMOS33
NiA

LVCMOS33(LVCH

b

| Clock Resource

Route Priority

Cell Mapping | Globs ql}l

[0

-

Zi™

Output | Tel Consola | Error | Warning | Info |
Ready

Mem Usage: 178,700 K

E—

3. fEHEN FPGA 4 fERT, IDE AR TH, K. W THRIEMZRISIE, <H5)

WO, DI R ERARD AT,

-

il Programmer: Getting Started

[P

Select an Actien

@ Create a mew project from

a JTAG scan

Cable: [H#-USEN-ZE (FTDI)

v | Port: |FTUSE-0

) |

Detact Cable

() Create a new blank projec

(") Open an existing programm

t

er project

"
| F:fforkspace/ fpgaproject 123 impll Finpll. et ¥
Import file to current implementation r
||
F:Morkspace/fpzaprojectfand? gatefimpllSimpll. xeof []
0E || Cancel |
.

b HNGTE FRAEG, AERET o
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() Start Pege [ | Reports [ | [7 anazv [] | i7 Spreadsheet Vien [ | i Programmer - inpll.xcf * [ |

XYYl

[a]x]

Enable Status Device Family

1 Machx02

Device

LCMXO02-4000HC

Operation

FLASH Erase,Program,Verify ...ace/fpgaproject/and2_gate/im|

4 1

File Name

Cable:

Fort

) Use

Cable and I/0 Settings

Cable Ssttings

Custom port:

I/0 Settings
@ Use defanlt If0 settings

custom If0 settings

[T INITH pin connected
IOHE pin connected
[T TRST pin connected

@ Set TRST high
Set TEST Low

b 7] PROGRAMH pin conmected -

Detect Cable
Hi-USEF-2B (FTDI) =
)

m

5. FER5ERsE, FEHEN PASS.

| ( Start Page |:| |

5 Reports |:i I E‘_’) and?. v |:J | :@ Spreadsheet View |:J | UProg:ranner L inpll.xcfﬁ
o BB @ B &

Enable Status

- !E . e

Device Family

Device

LCMXO2-4000HC

Operation

FLASH Erase,Program Verify ..aceffpgaproject/and2_gate/im

File Mame

2, Hr TR RIZRE L,

24

BT RIZER THEVNAY LR IET

ZATE.

3.7 /NG

MEE—F FPGA I — R IT KB B

1. #TRE, S TRERE. Shki

DGR

SR T SRR A S 12, A
FHWE /N8 (K. K2) SR¥%H LED 4T (LDD) 5K, 7E FPGA 1R b LD1 {55 A mi), LD1
A5 2 D1 HIME S ONRET, LD st T4 HE K1 A1 K2 MILEIRAS 2 &,
Bi%. PUREFIBITE, HEAEE— MR WA EEIN 2T, o1 &5 BNE, b1 M

AL PSS
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2. BN, — A BIERSCRR AR T, SCRIE, — A REH Verilog B TR
3. JiRLEA (Synthesis), JGATAFINREZ IRRIE N BT RGN NKZ R INHE
AT LA B RS RTL JZ K E]
4, WINZIHR, BFESECER, v DU BRSO NP R 7 20
v WU, HZRE AR RTL IR ORI € FPGA O AHDCIZ A4 B
6. MJRATLE, WSS IZAETE FPGA O RS E AT R A 4%
7. ilE (Verification), GIER T HAMIIEETE, —MK245E ModelSim 45 testbench i
A7
7+ AR AT B G PRI S S
8. FELAESCHRIF RN, HFE A IERICE
9. RN
FUAS T BRI AR 0] DA g L rp ) — D IR, B EARCE R .

4. {fE T HE Active-HDL

FPGA Wit iR — /N5 B0 B st & 1 B, Diamond M4 JF & ¥R 55 [A i 48 1% 1
Active-HDL T-H, FHE B W #4T hae(i B

1. EIHE A testbench X, THEMBIE Verilog P —FE. FeAlldr 44 and2_tb

Fle Edit View Pro_]ecl Design  Process Tools Window Help
i HLaJlg] @@%Eﬁﬁﬁ i [ M@ a";a_ée.ild = B & El
E@.ﬂﬂ%  EHSCEEGR=UQoBR> HENEE:@

File Llst g X (‘ Start Fage |_| | " Reports |_| | E-)an&_tb.vm |
4 [[§ and2 “timescale 1ns/100ps
L3 LCMXO2-4000HC-4MG132C
4 | Strategies
F% Area
I/O Assistant
Quick
% Timing
Strategyl
4 [fH impl1
4 | Input Files
and2.v
I Ao and2_tha
|, Synthesis Constraint Files
4 || LPF Constraint Files
Y and2.lpf
|, Debug Files
. Script Files

cmodule and2 th;

req a,b;
wire ot

initial
=] begin
a=0o;

#50

#50

| Analysis Files
4 . Programming Files

impll/impllxcf

File List | Process I Hierarchy | 1

Jutput

2. testbench MK TN AT :



STEP-MX02 %AFF it

‘timescale 1ns/100ps

module and2_tb;

reg

wire

a,b;

G

initial

begin

end

a=0;
b=0;
#50
a=1;
b=0;
#50
a=1;
b=1;
#50;
a=0;
b=1;

and2 and2_ul(

);

endmodule

3. XEFHEERNAMBM R RN, IREZERRATLREN, 2 5

MR, £ TR H 3 B A # i and2_tb 3C1F,
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4 [} and2

i LCMX02-4000HC-4MG132C

4 | Strategies
[%‘ Area
I/O Assistant
% Quick
E® Timing
Strategyl
4 [fH impl1
4 | Input Files

¥ and2w

and2 th-

. Synthesis (

4 N LPF Constr
[ and2lg

. Debug File

1. Script Files

. Analysis Fil

4 | Programm

Bl imply

File List Frocess |

tput
(VERI-1482) RAnalyz
INFO - F:/Workspag
INFO - F:/Workspag
INFO - F:/Workspag

#50
a=1;
b=0;
¥50
a=1;
=]_;
¥50;
a=0o:
=]_;
end

Open
Cipen With...
Cpen Containing Folder

Add ’
Clone Implementation...

Clone Strategy...

Find Files...

Exclude from Implementation

Remove

Set Top-Level Unit...
Select Synthesis Toal...

Include for »

andZ ul (

dule

/fpgaproject/and2 gat
tb.v(3,8-3,15) (VERI-
tb.v(3,1-29,10) (VERI
by (1,1-13,10) (VERI-S0

Done: de=sign load

Properties

{0} warnings

P —AS R O, BRSO R SO simulation R RS H .

21._ Project Properties

4 [} and2
4 LCMXO2-4000HC-4MG132C
s [EH impl1

and2.v
and2_tb.w
and2.lpf
impl1/implLlxcf

r—i” Area

E#® 1/0 Assistant

E¥ Quick

E# Timing

Strategyl

Hame: and?_th. w

Category: Resource

Location: FifWorkspace/fpzaproject/and? gate

Verilog Include Search Path

¥alue

Include for

Simulation -

] [ Cancel
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4y Al T ARG TR SR
Fle Edit View Project Design Process Tools Window Help

A-B-HId B 2w Hn L0e/BE BEEED
CECGRETEGCHEGM sBxT| BEEEE 6

File List g X | Q Start Fage Reports |:| | rf alldz_tb-"m |

B & Tool->Simulation Wizard

+ Lattice Diamond - Seurce Editor - [Fi/Werkspace/fpgaproject/and2 gate/and2 tbv] ———— [ )
File Edit View Project Design Process Window  Help
H-E-H P @1 Y [T [ i# Spreadsheet View E:EEE O
m Package Vi
CESRAECES O L ekt FEEEHE e
File List 5 x Vewcd Vet [/ andz_sb.v [=]¥]
a and? Nel\:s( Ar\s\yzer 0ps =
I LCMXO2-4000HC-2MG132C Netlist View
4 1 Strategies NCD View
% Area
[ 1/ Assistant IPexpress
& Quick i Reveal Inserter
[E% Timing A
Strategyl @ Reveal Analyzer £
< Eimp Floorplan View
4 |, Input Files | physioal Vi
¥ and2v [ Physical View
Ao and2_tby @ Timing Analysis View
|, Synthesis C?nstsﬁini Files 8 Power Calculator LA
4 || LPF Constraint Files -
P andzipf 5E ECO Editor
| Debug Files izt Programmer
I. Script Files
a
B Analysis Fles N Partition Manager
4 i Programming Files < synplify Pro for Lattice
i Ll [ Active-HDL Lattice Edition
File List | Procsss | Misrarchy | _ £B_Run Manager i v
o [ Simulation Wizard ] —
(VERI-1482) REmalyzing Verilog file Clear Tool Memory ga/userware/NT/SYNTHESIS_ HEADERS/machxol2.v
(VERI-1482) Rnalyzing Verilog file 7qa|:e/ami2.v
INFO - F:/Workspace/fpgaproject/and Options.. -1018) compiling module and2
INFG - F:/Workspace/fpgaproject/andZ= = - T T-9000) elaborating module ‘'and2'
Done: design load finished with (0) errors, and (0) warnings ol
Output | Tl Consele | Error | Warnmingé | Infor |
Ready Mem Usage: 196,908 K
] = = L

5. Bt R M SE M,
.r:_n Simulation Wizard : E; B

Preparing the Simulator Interface

Thiz wizard will guide you through the creation of a new simulation project for
a specific simulater.

To create 2 mew simulator project you %ill need to provide 2 name and location
for your project. Wext wyou will indicate what stage of the FPGA implementation

wou wish to zimulate.

Click Wext to continue.

B = = T e e—— —

6. A ARMITEELE—N4TF,
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=

ke

21 Simulation Wizard Ii‘ihj

Simulater Project Hame
Enter a name for mour simulator project and specify a directory where the project file
will be =stored.

Froject nama: test
Froject location: F./Workspace/fpzaproject/and?_gate [::::j
Simulator
@ pctive—HDL
MadelZim/BuestaSim

| < Back ][ Fext > ]| Cancel

7. PR B, X EZDIREI . Frel HRgik RTL 2.

L

¥ B
21 Simulation Wizard Ii‘ihj

Process Stage
Indicate what process stage of the FPGA implementation strategy you wish to simulate.
hvailable stages are antomatically displayed.

Frocess Stage
@ RIL
Post—Map GateLewvel

Fost-Route Gate-LeveltTiming

| < Back ] [ Fext > ] | Cancel l

8 e FEUN N B M ok i A7 S AR SR AN S, Wi SR T Copy Source to Simulation
Directory JEI, KF<#8 DG SO 2005 1 TR H %
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=

21 Simulation Wizard

2 ) |

Add and Reorder Source

4dd HIOL type source files and place test bench files under the design files.

Source Files:

& ) @] (&) &

F:/Workspace/fpgaproject/and2_gatefand2.v
F:/Workspace/fpgaproject/and2_gate/and2_tb.v

I ti Copy Source to Simulation Directery

[vﬂ Automatically set simulation compilation file order

| < Back | [ Fext > ] | Cancel

ke

o. MIE LIRS, WIRAT 2 NI AT LUk £ TR M0

21 Simulation Wizard

2 ) |

Parse HOL files for simulation
Parse HOL files for simulation.

Simulation top parsing finished.

R

—— Analyzing
-— Analyring
== Anazlyzing
—— Analyzing
-— Analyring
== Anazlyzing
—— hnalyzring
-— Analyring
—— Analyzing
-— Analyring
-= Anazlyzing

YHOL

file
file
file
file
file
file
file
file

C:flscefdiamond/3
C:/l=zcefdiamond/3
C:flscefdiamond/3
C:/flsce/diamond/3
C:fl=zcefdiamond/3
C:flscefdiamond/3
C:f1scefdiamond/ 3
C:fl=zcefdiamond/3

e g e S - ———

LB_xB4fispfpgalvhdl_packagesfstd logic_textio. vhd (YHDL-1481 #
CB_xBdficpfpza/vhdl_packagesfsyn_attr. vhd (VHOL-1481)

. B_xB4fispfpgalvhdl_packazesfsyn_mize. vhd (VHDL-1481)
CB_xBdfispfpzalvhdl_packagesfmixed lang wltype vhd (VHDL-14f
CB_xBdfispfpzafvhdl_packagesfsyn_ arit. vhd (VHOL-1481)

L B_xB4fispfpgalvhdl_packazesfsyn_zign. vhd (VHDL-1481)
CB_xBdfispfpzafvhdl_packagesfsyn_unsi. vhd (WHDI-14510

LB _xBdfispfpza/vhdl packages/synattr. vhd (VHDL-1481)

Verilog file F:/Workspace/fpzaproject/and?_gatefand?. « (VERI-1482)

YVerilog file F:/Workspace/fpzaproject,/and? gatefand? th w (VERI-148Z2]

VHIL file C:/lscefdiamond/3. 6_x64/cae_library/=synthesis/vhdl/ macheoZ. vhd (VHDL-1481)

m.

1L

Simulatieon Top Module:

and?_th

| < Back | [ Hext > ] | Cancel l

L

10, P TREWUH S5, AR TR E , S E5E R B shPiT 0 JOF Rosipr 3

.
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T Simulation Wizard M

Summary

Simulator : Active-HDL -
Project Name : test

Project Location : F;f/Workspace/fpgaproject/and2_gate
Simulation Stage : RTL

Simulation Files :

m

F:i/Workspace/fpgaproject/and2_gatefand2.v
F:/Workspace/fpgaproject/and2_gate/and2_tb.v
Simulation Libraries :

pmi_work ==
ovi_machxo2

Simulation Top Module : -

Fun simulator
hdd top-lewel =signals to waveform display
Bun simulation

< Back ][ Finish ][ Canzel

L= = —— = — e = — = ¥
JESNITN = = —a N A
11, SERATEIRSE, PATITE SR B .
Active-HDL 10.2 (test test) - untitled.awc * — = = 2 |
File Edit Search View Workspace Design Simulation Waveform Tools Window Help o ox
BrEd | z9E @F B RE0H YO0 % @088 [ p e o Hem |5 2
| 4 r%Hﬁmm%ﬂiaxl«»ﬂMﬂ4%%nml%l@M!lI%&éj
Iﬁ'ﬁ,andZ_ﬁb j Signal name Value a0 1501 BT 50 400 - 80 - 560 s
Hierarchy 2 e 0 S l i
ar b 1
wc 0 1
—3F and2 ul : and2
B QINITIAL#E 0@ ~ 3
I =
MName |Va\ue L
R=a o
R=b 1.
= 0 Curszer 1 -
c
[ ] —| 2 [HEE)
il o ‘. } wave.asdb SIM
=] Files /¥#Stru... /Res..../ | T
=# Simulation has been initialized -

=# Selected Top-Lewel: and?_tb (and?_tbh)

= add wave *

=# 3 signal(s) traced.

= run 1000ns

= # Waveform file “untitled. awe’ comnected to *F:/Workspace/fpgaproject/and?_gate/test/src/wave. asdb’. ]
«# KERNEL: stopped at time: 1 us

=# KERNEL: Simulation has finished. There are no more test wectors to simulate. %

B Console [

[T hns 4
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5. STEP-MXO02-C x4~

5.1 STEP-MXO02-C JRAEZER

/NI STEP-MX02-C 25 STEP-MX02 AHALLH — ZKBE R A, EAIT 2 B e R X 3 il =& T %%
P2 FPGA 5 177 RAS—HE . STEP-MX02 238 i JTAG #5 =X F #k Se 44, 11 STEP-MX02-C
& B4l USB REAE, @i SO D7 3. BRI 22 )1 225 SCRY STEP-MXO02 fifi 4
i

5.2 STEP-MXO02-C F#HHF R

1. fHFH/NEY STEP-MX02-C B, % T T F2 2 A sl g 3 SO 72 5 22 /i STEP-MX02 TR R
S, ANHEPRE 3.6 T FERX—5.
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